
 

 

 
                                                                                                                        

 

Monthly General Meeting 
Date:  July 26 , 2008 

Agenda:  

 0830-0900    Random Access (general Q & A on IBM-compatible, personal computer hardware and software)  

 0900-0915    User Group Administration and SIG Announcements 

 0915-1015    Featured Presentation 

TBD 

 1015-1030    Break 

 1030-1110    Featured SIG Presentation (Hardware SIG) 

          òAn In Depth Tour of the Hardware SIG Web Siteó 

1110-1155 Capsule SIG Presentations: 

   Windows SIG ð Firefox 3.0 

Digital Content, Scanning, & Printing SIG ð video of making a glamour print.  

Internet & Networking SIG ð TBD (let Steve know what youõd be interested in hearing about) 

 1155-noon    Raffle  

Raffle tickets are FREE - five (5) to each member attendee and one (1) to each adult, non -

member attendee; please pick them up when you sign in.   The monthly raffle prize is a $50 Fry's 

Electronics gift card.  

Location :   

 All meetings are held at the Costa Mesa Senior Center, 695 West 19th Street, Costa Mesa, CA 92627 

 

Copyright © Orange Coast IBM PC User Group 2008 

 

Orange Coast IBM PC User Group (OCIPUG) 
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OCIPUG is a member of 

APCUG     (Association of 

Personal       Computer 

User Groups) 

  

http://www.cmseniorcenter.org/cmsc_map.htm
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Meetings 
 

General Meetings ð next six months  (minimum) : 

 July 26, 2008 (see cover page for this monthõs meeting agenda) 

 August 23, 2008, September 27, 2008, October 25, 2008, November 22, 2008, December 20, 2008 

 

Executive Board Meetings  ð follow each General Meeting.  OCIPUG members are welcome to attend.  

 

Special Interest Group (SIG) Meetings :  

 First Tues day (July 1, 2008) ð Internet & Networking SIG  

  7:00 P.M. ð 9:00 P.M. 

 Featured Topic:  Firefox 3.0 plus Q&A 

  SIG Leader: Steve Schiffman  

  Internet & Networking SIG web site ð click the òInternet & Networkingó link on the OCIPUG web site 

 Second Tuesday (July 8, 2008) ð Hardware SIG 

  7:00 P.M. ð 10:00 P.M. 

 Featured Topic:   òBuilding Your Own System (2008 Series) ð Sourcing Your Components (the second 

session in a five part series)ó  

  SIG Leader: Ed Leckliter 

Hardware SIG web site ð click the òHardwareó link on the OCIPUG web site 

 Third Tuesday  (July 15, 2008) ð Windows SIG 

  7:00 P.M. ð 9:00 P.M. 

 Featured Topic:  Windows XP SP3, things to do before you install it ,  plus Tips and Tricks.   

SIG Leader: Robert Strader  

  Windows SIG web site ð click the òWindowsó link on the OCIPUG web site 

 Fourth Tuesday  (July 22, 2008) ð Digital Content, Scanning, & Printing SIG 

  7:00 P.M. ð 9:00 P.M. 

  Featured Topic:  How to do òspecialó printing. 

  SIG Leader: David Wintle 

 Digital Content, Scanning, & Printing SIG web site ð click the òDigital Contentó link on the OCIPUG web 

site  
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Administration (Team Roster ς 2007-08) 
 

President 

Vice President 

Secretary 

CFO/Treasurer 

Director (2006-08) 

Director (2007-09) 

Past President/Long Range Planning 

README.DOC Editor 

Webmaster 

Programs Chairperson 

SIG Coordinator 

Membership Chairperson 

APCUG Representative 

SCRUGS Representative 

Ed Leckliter  

Robert Strader 

Irwin Haydock 

Jack Vincent 

Eugenia Frerichs 

Leonard Stein 

David Wintle 

Ed Leckliter  

Ed Leckliter  

David Wintle 

Robert Strader 

OPEN (= Opportunity!)  

Robert Strader 

Robert Strader 

president.bod@ocipug.org  

vicepres.bod@ocipug.org 

secretary.bod@ocipug.org 

treasurer.bod@ocipug.org 

director1.bod@ocipug.org  

director2.bod@ocipug.org  

pastpres.bod@ocipu.org  

editor@ocipug.org 

webmaster@ocipug.org 

programs@ocipug.org  

sigcoordinator@ocipug.org  

membership@ocipug.org  

apcugrep@ocipug.org 

scrugsrep@ocipug.org  

 

Membership 
 

Members receive a meeting reminder and the monthly newsletter (README.DOC) via e-mail (the online newsletter 

archive is on a three month delay).   Member dues help the group pay its bills (liability insurance, APCUG membership 

fee, equipment maintenance, web site domain name registration and hosting fees, and raffle prizes).  Memberships run 

from September through  August and are prorated for those join ing after September.  The membership form is available 

at ( link ).  The fee schedule follows.  Contact the OCIPUG Treasurer for prorated fees .  

Individual ð 1 year $30, 2 years $55, 3 years $75 

Family - 1 year $35, 2 years $60, 3 years $85 

Full-time student - $20/year  (see the membership form for more info)  

 

OCIPUG Web Sites 
 

Main web site - see http://www.ocipug.org/    

SIG web sites ð click the associated SIG-name link on the OCIPUG home page (http://www.ocipug.org/ ) 

 

mailto:president.bod@ocipug.org
mailto:vicepres.bod@ocipug.org
mailto:secretary.bod@ocipug.org
mailto:treasurer.bod@ocipug.org
mailto:director1.bod@ocipug.org
mailto:director2.bod@ocipug.org
mailto:pastpres.bod@ocipu.org
mailto:editor@ocipug.org
mailto:webmaster@ocipug.org
mailto:programs@ocipug.org
mailto:sigcoordinator@ocipug.org
mailto:membership@ocipug.org
mailto:apcugrep@ocipug.org
mailto:scrugsrep@ocipug.org
http://www.ocipug.org/Other%20Docs/OCIPUG%20Membership%20Form%2006112008.pdf
http://www.ocipug.org/
http://www.ocipug.org/
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SIG Meeting Reports 

 

Internet & Networking SIG (SIG Leader: Steve Schiffman  

 Meeting Date: June 3, 2008 

 Attendees: 6 

 Topic/Focus: Sig Leader Steve Schiffman continued his three part series on Network Firewalls and how they are 

implemented in both Windows software and in routers. This evening the challenge was to use the realVNC application to 

remotely control one computer from another across our local LAN. We installed the VNC Server application on one of 

the SeniorNet computers and the VNC client on the OCIPUG computer and on one of oǳǊ ƳŜƳōŜǊΩǎ ƭŀǇǘƻǇǎΦ CƻǊǘǳƴŀǘŜƭȅ 

for the SIG Leader, the application installs worked, the network behaved and the firewalls cooperated. We were able to 

have the client PC connect to the VNC server PC and control its functioning. 

Hardware SIG (SIG Leader: Ed Leckliter)  

 Meeting Date: June 10, 2008 

Attendees: 7  

Topic/Focus: òBuilding Your Own System (2008 Series) ð Planning Phaseó 

See presentation slides (PDF format).  

Hardware Submissions: None 

Random Access:  

1. Visitor Frank Athis inquired about Edõs thoughts on slowing down or pausing system hard drives to save 

energy (S4/Suspend to Disk).  Ed noted that there are actually many things a system does to save energy:  

a. Blanks the display or starts a screen saver.  Savings here depend primarily on the type of monitor 

being used.  LCD panels draw very little power, so saving s will likely be nominal.  

b.  The system power state (Sx) defines most of the rest.  Per Intel ( link ):  

ñNewer computers feature ACPI (Advanced Configuration and Power Interface), which extends the 

APM concept to allow the OS to selectively control power. ACPI supports a variety of power stateséò 

A quick synopsis:  

S0 On and fully operational. 

S1 System is in low power mode (a.k.a. sleep mode). The CPU clock is stopped, 

 but RAM is powered on and being refreshed. 

S2 Similar to S1, but power is removed from the CPU. 

S3 Suspend to RAM (a.k.a. standby mode). Basically, most components are 

 shutdown except RAM. 

S4 Suspend to disk (a.k.a. hibernate mode). The memory contents are swapped  

http://www.ocipughwsig.org/PDFs/OCIPUG%20Hardware%20SIG%206%2010%202008.pdf
http://www.intel.com/support/network/sb/CS-000084.htm
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to the disk drive, and then reloaded into RAM when the system is awakened. 

S5 Power off.ò 

The amount of power saved stepping through these levels varies primarily with the power required to 

operate the associated component(s) and the length of time during which the system was in the noted 

state.  Ed said that from articles he has read, the annual savings are between $20 and $80 per PC. 

c.  The processor (CPU) also has power states (Cx). Ed did not address power savings associated with 

processor power states. Check Intelõs site for more info. 

d.  Ed also noted that, in his experience, some system òproblemsó are òcausedó by users and systems 

recovering from (coming out of) a power saving state. Ed said he sets up his systems to disable the 

power saving features AND turns off his system when not in use.  

2. Member Walter Srebnik noted that purchasing a new, very inexpe nsive system might work for some 

applications he has, but that he hates the fact that you seldom get a copy of the operating system with 

your purchase (entry level on up).  Ed òrespondedó that there are a couple of key factors involved. 

a. You get what you pay for.  The larger system OEMs do not purchase an operating system license 

that can be used on another system and therefore they pay less for it ð helping keep down the 

system cost, and the price to you.  Mid -sized and smaller system builders buy a more expensive 

license (actually a license and media bundle) which is transferrable - and the end user customer 

òshouldó get the installation media.  [The super low cost, òloss leaderó systems are generally only 

available from the larger system OEMs.]  

b. Should there be a software òproblemó or hardware failure, the system supplierõs objective is to get 

the customerõs system back to the òstateó it  was in when they first booted it up, i.e., the same 

operating system, driver, and application software òloadó, working perfectly.  They typically do 

that with a òrestore partitionó or òrestore CD (or DVD)ó ð a òhiddenó area on the system hard drive 

or a CD/DVD disk, respectively,  that includ es all the required software AND  the automated 

installation òproceduresó needed to get the customer back to Day One bliss.  Ed noted that this 

puts the user miles ahead of where he/she would be if they needed to start with an operating 

system installation, find and load drivers, and find and load any useful applications or utilities that 

came pre-installed.  In Edõs estimation this is absolutely the òrightó way to handle the issue of 

recovering from a problem ð from the system OEMõs AND the typical customerõs point of view. 

Windows SIG (SIG Leader: Robert Strader  ð Steve Schiffman substitute d for Bob ) 

 Meeting Date: June 17, 2008 

 Attendees: 5 

 Topic/Focus: To welcome back SIG Leader Strader who had just returned to town the previous evening, we 

played a uTube video of model trains running on the layout at the K -10 Trains hobby shop. In previous meetings Steve 

Schiffman had mentioned the K -10 Trains hobby shop in Marysville, Ill that had a humongous layout at the back of the 

store. Bob was in the area just East of East St. Louis visiting family and was able to stop in and see the layout I had 

been talking about. He even bought some   trains and a new fangled train controller. The video showed trains running 

on the highly detailed layout, a video log of sorts to honor Bob and his travels.  

 

Now onto the program of the evening. To start off Networ k SIG Leader Steve Schiffman continued his three part 

presentation on network firewalls. This segment was the setup of a network of two routers connecting via the internet. 

Four of the attendees had their notebook computers which were connected to the swit ch side of the routers, two on 

each end of the network. The respective router /switches used their DHCP to assign IP addresses to the computers on 

their side of the network. The routers were assigned an external IP address for communication over the web. A s with 

many demonstrations, we had an equipment failure and had to replace  one of the routers with the meeting room  
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router. Steve a lso did a chalk talk to show how the network was being configured. In August, with working routers, we 

will continue with the  router firewall configuration effort to allow our remote control program to communicate over 

the internet to a computer to make our application work.  

 

We want to welcome a new OCIPUG member John Soley who joined up at the SIG meeting.  

Digital Content, Sca nning, & Printing SIG (SIG Leader: David Wintle)  

 Meeting Date: June 24, 2008 

 Attendees: 5 

 Topic/Focus: Further discussion of the òOrganizeró feature in Photoshop Elements 6.  Worked on a photo 

member Irwin Haydock brought in.  

 

Articles 
 

Email Etiquette  

Attribution:  By John Roy, President, The PC Users Group of Connecticut  (www.tpcug -ct.org ), j ohnroy1@comcast.net   

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

Do you really know how to forward an e -mail? It is estimated that over fifty percent of email users do not know how to 

do it properly. Do you wonder why you get viruses or junk mail? Email messages get forwarded countless times without 

concern for the security of the previous senderõs addresses.  

Every time you forward an e -mail there is information left over from the people  who got the message before you, 

namely their e -mail addresses and names.  As the messages get forwarded along the list of addresses builds and builds 

creating a huge resource for spammers. All it takes is for someone to get a virus and the infected comput er can send 

that virus to every e -mail address that has come across that computer. Even if the address collection doesnõt result in 

a virus it surely will be harvested by spammers or someone looking to make a couple of cents for a listing of good email 

addresses. How do you stop or at least minimize the propagation of email addresses? There are several easy steps that 

we should all practice.  

(1) Before you send out a forwarded e -mail, DELETE all of the other addresses that appear in the body of the message  

(at the top). That's right, DELETE them. Highlight them and delete them, backspace them, cut them, whatever it is you 

know how to do. It only takes a second You MUST click the 'Forward' button first and then you will have full editing 

capabilities against  the body and headers of the message. If you don't click on 'Forward' first, you won't be able to edit 

the message at all.  

(2) Whenever you send an e-mail to more than one person, do NOT use the To: or Cc: fields for adding e -mail 

addresses. Always use the BCC: (blind carbon copy) field for listing the e -mail addresses. This is the way the people you 

send to will only see their own e -mail address. If you don't see your BCC: option click on where it says To: and your 

address list will appear. Highlight the address and choose BCC: and that's it, it's that easy. When you send to BCC: your 

message will automatically say 'Undisclosed Recipients' in the 'TO:' field of the people who receive it.  

(3) Remove any ôFW:' in the subject line. You can re -name the subject if you wish or even fix spelling.  

(4) ALWAYS hit your Forward button from the actual e -mail you are reading. Ever get those e -mails that you have to 

open 10 pages to read the one page with the information on it? By forwarding from the actual page you wish someone 

to view, you stop them from having to open many e -mails just to see what you sent.  

http://www.tpcug-ct.org/
mailto:johnroy1@comcast.net


 7 

(5) Have you ever gotten an email that is a petition? It states a position and asks you to add your name and addres s and 

to forward it to 10 or 15 people or your entire address book. The email can be forwarded on and on and can collect 

thousands of names and email addresses. A FACT: The completed petition is actually worth a couple of bucks to a 

professional spammer because of the wealth of valid names and email addresses contained therein. If you want to 

support the petition, send it as your own personal letter to the intended recipient. Your position may carry more 

weight as a personal letter than a laundry  list of names and email address on a petition. (Actually, if you think about 

it, who's supposed to send the petition in to whatever cause it supports? And don't believe the ones that say that the 

email is being traced, it just isnõt so!)  

(6) One of the main ones I hate is the ones that say that something like, 'Send this email to 10 people and you'll see 

something great run across your screen.' Or, sometimes they'll just tease you by saying something really cute will 

happen IT AIN'T GONNA HAPPEN!!!!! (Trust me; I'm still seeing some of the same ones that I waited on 10 years ago!) I 

don't let the bad luck ones scare me either, they get trashed. (Could that be why I haven't won the lottery?)  

(7) Before you forward an Amber Alert, or a Virus Al ert, or some of the other ones floating around nowadays, check 

them out before you forward them. Most of them are junk mail that's been circling the net for Years! Just about 

everything you receive in an email that is in question can be checked out at Snop es. Just go to 

http://www.snopes.com/. Itõs really easy to find out if it's real or not. If it's not, please don't pass it on.  

So please, in the future, let's stop or at least minimize the junk mail and the viruses by taking the steps outlined 

above. 

This article has been provided to APCUG by the author solely for publication by APCUG member groups. All other uses 

require the permission of the author (see e -mail address above). 

Windows Vista Upgrade Advisor  

Attribution:  By Ed Leckliter, Orange Coast IBM PC User Group (OCIPUG) and the associated Microsoft web site.  

During a recent OCIPUG Hardware SIG meeting I mentioned that an excellent way to figure out whether someoneõs 

current PC hardware and software applications will òtransferó to a new PC is to run Microsoftõs òWindows Vista 

Upgrade Advisoró on the current PC and review the results.  [This was brought up in the context of a presentation  on 

òBuilding Your Own System ð Planning Phaseó, the first in a five part series on building a ònewó PC.  The point being 

made was that the user may wish to carry over some of th e hardware from the òoldó system to the new system and at 

some point run Vista.   The suggestion being that if the Microsoft utility advised that the hardware and/or software 

would not be supported under Vista ð and there was no known workaround ð then the new system spec needed to be 

defined accordingly.]  

As you may know, Vista is a rather demanding operating system from the hardware side IF you want to use the major 

new bells and whistles.  Anticipating negative feedback (complaints) from less-well -informe d operating system 

upgraders, Microsoft worked with hardware and software manufactures to test alpha and beta versions of the new OS 

on systems built with òolderó as well as the newest and upcoming system hardware component s and software 

applications .  They then developed a software application (the òAdvisoró) to interrogate the userõs current system to 

determine its current hardware and software configuration, compare the results to the  developed database of 

òcompatibilityó data, and report the results to the user.  The òreportó even advises the user about possible 

òworkaroundsó.  Very nice!  

Here is Microsoft has to say: 

òWhat is the Windows Vista Upgrade Advisor? 

Windows Vista Upgrade Advisor is a downloadable web application that helps Windows XP users identify which edition 

of Windows Vista meets their needs, whether their PCs are ready for an upgrade to Windows Vista, and which fe atures 

of Windows Vista will be able to run on their PCs. The end result is a report that explains which edition of Windows 

http://www.ocipug.org/Other%20Docs/OCIPUG%20Membership%20Form%2006112008.pdf
http://www.microsoft.com/downloads/details.aspx?FamilyId=42B5AC83-C24F-4863-A389-3FFC194924F8&displaylang=en
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Vista to buy and provides suggestions about what, if any, hardware updates may be necessary to install and run the 

appropriate editi on and features of Windows Vista. Running Windows Vista Upgrade Advisor is a great first step for 

anyone considering whether to install Windows Vista on a PC they already own. ó 

Here is a visual of the opening screen.  

 

And here are the results of a scan do ne on my desktop system.  [The download is 6.6MB ð under a minute using cable 

modem.]  
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NOTE:  The above is a lot of good data.  In my situation, however, w hat it doesnõt show is compatibility with my main 

printer , which is parallel port and was powered on when the test was run.  It is unclear to me whether the Advisor 

even saw that  printer .   

Frankly, knowing what software applications I have on my system, I would do a lot of checking before I assumed theyõd 

be OK running in a Vista environment.  That said, the primary point of the discussion during the OCIPUG Hardware SIG 

meeting was to check for hardware compatibility.  From the òreportó, that appears to have been addresses.  YOUR 

results may vary.  

This article may  be reproduced with attribution to the author and OCIPUG.  
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E-Mailing Photographs  

Attribution: By Richard Kennon, Editor, Amador Computer Users Group, CA (www.acug.net ), Drtrdguy @volcano.net   

Obtained from APCUG with the author's permission for publication by APCUG member groups. 

First, we must  understand that photograph  (image) size in the camera and in the computer is measured in pixels . 

These are the basic dots of color that make the picture. Do not pay any attention to anything that says òinchesó or 

òpixels per inch.ó These terms are meaningless when we are considering a picture either in the camera or in the 

computer. They may come into play later if we want to print the photo on paper. But, that is another subject for 

another time . For now, we think only of pixels. Most cameras record too many pixels to e-mail. For instance a 6 

megapixel camera will make a picture about 3000 pixels wide by 2000 pixels tall  and the file size may be several 

megabytes. Our screens are usually only about 1000 pixels wide (some are larger and some smaller).  So, if we e -mail 

the native picture, it will be wider than the screen for the recipient and the file will be so large, it may take òforeveró 

to download to the recipientõs computer. It is possible the service provider will not even accept it.  

There are two things we m ust do to make a photo e -

mailable. The first is to resize  or resample  the 

picture. We want to change the picture width from 

3000 pixels to 800 pixels, for instance. This process is 

called resizing or resampling.  We have to pick the 

best 800 pixels out of t he 3000 to represent our 

photo. Well, no, t hat is not exactly correct but it 

simplifies things to think of it that way. We donõt 

have to worry about it because a lot of very smart 

programmers have developed ways (algorithms)  to 

help us. Just remember, you want to resize or 

resample to get the photo down to a size convenient 

for e -mailing.  I usually use 800 pixels or 900 pixels 

width for pictures I attach to e -mails.  

The second thing to do to make a photo e -mailable is 

to save it in JPEG format (.jpg).  That is a format that 

reduces file size a lot and picture quality a little so 

the picture can be downloaded more quickly and still be nice to look at. Some software programs give you choices of 

compression amount with numbers ranging from 1 to 10. One will re sult in a very small file but the picture quality will  

not be good at all. A 10 will give the very best quality but with a very large file size. A reasonable compromise is to us e 

5 or 6.  I usually use 6. 

How do you do this? First, I will describe how to do it with a free Microsoft program . Then I will try to look at some 

other programs.  

Microsoft Power Toys for XP has a Resize Pictures toy that is slick and easy but feedback says it only works on XP. It can 

be downloaded at http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx . Right click on an 

image name or thumbnail in Explorer or My Computer and choose Resize Pictures. You are limited to four spec ific sizes 

but they are good choices. They donõt tell us what compression they are using but the results look OK. Unless you tell 

them under Advanced  to replace the image in the file, it will make a copy. Thatõs good. They will add the word, 

òLargeó, òMediumó or òSmalló to the end of the name you have chosen.  

If you are happy with this solution, then read no further. But, if you want to use a picture editing program, maybe this 

will help.  

http://www.acug.net/
mailto:Drtrdguy@volcano.net
http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
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In Photoshop Elements 5, click on Image>Resize>Image Size and thi s window will pop up. Note that there is some 

garbage at the bottom about òinchesó but we will ignore that. First we will click 

the Resample Image box. That puts the Pixel Dimensions in play and that is what 

we want. I selected the Width box 

and changed the width to 800 pixels. 

Since the Constrain Proportions  

box is selected, that is all I have to do.  

Note, down at the bottom, that we have 

several choices of sampling algorithms. 

This is frosting on the cake. I read 

somewhere that I should use Bicubic 

Sharper  when downsizing so that is what I 

do. Most programs donõt give us all these choices. Then we should click on 

File>Save As and give the photo a new name. I often just use the same name 

and add ò_800pxó so the next time I will know it is ready to e-mail.  Here we can 

choose the JPEG format and the compression amount. Photoshop Elements 6 is 

out now and sells for about $100. If you are able to spend that much and want one of the best editing programs, I 

highly recommend it.  

 

Letõs look at Picasa2. It is a free program from Google and looks really good but I 

do not have much experience with it. By all means, try it first because the price 

is right! When it comes to e - mailing 

photographs, it is a little more automated 

but not any easier to use than Elements. 

First, click on 

Tools>Options>E-Mail. Then select the 

width you want in pixels. There are six 

choices. Then click on Apply  and OK.  

The next step is to click on File>E-Mail 

and you will get three choices of how you 

want to e -mail your photos. Fortunately , I 

use Outlook Express so my choice is 

listed.  

When I clicked on Outlook Express, an e-mail page popped up with the photo attached. At this point we can write 

something else on the e-mail and send it. I recommend this so the recipient will know it is rea lly from you and not 

something sent out by a virus. When I receive e -mails that only say òAttachedó, I Delete  them without looking at the 

attachment.  This saved me one time when I received a virus from my sister -in-law that she did not know she sent. She 

spent weeks and dollars getting her computer back up. Oh, I digress. If you want to send more than one picture (and, 

who doesnõt?), you must select the picture and click on the Hold button near the bottom of the screen. Do this for each 

photo you want to se nd and they will all be attached to the e -mail. The program automatically chooses JPEG format 

and a compression ratio but  does not tell you. That is OK as the pictures I tried looked good. Picasa2 has considerable 

capability for editing photos in many resp ects. Try it!  

There are many other editing programs that I havenõt mentioned and have no experience with. In all cases you want to 

change the pictureõs size in pixels by resizing or resampling. Pay no attention to anything that says òinchesó as that 

will have no meaning for this process. Sometime later we will talk about printing pictures and then we will use inches.  


